Enterprise Feedback Suite

EFS Qualitative Analysis

Version: 1.3
Date: 17.02.2012
## Contents

1. **EFS Qualitative Analysis** ................................................................. 5

2. **Virtual Tour** .................................................................................. 6

3. **Creating and Managing Projects** .................................................. 10
   3.1 Overview of Project Manager ...................................................... 10
   3.2 Creating Projects ...................................................................... 10

4. **Processing Quotes** ........................................................................ 12
   4.1 Overview of the Edit Dialog ....................................................... 12
   4.2 Searching Quotes ...................................................................... 13

5. **Managing Codes** ........................................................................... 15
   5.1 Overview of Encoding Features .................................................. 15
   5.2 Organizing Codes ...................................................................... 16
   5.3 Downloading the Code Tree ....................................................... 17

6. **Displaying and Visualizing Results** ............................................. 19
   6.1 Exporting Coded Quotes ........................................................... 19
   6.2 Visualizing Encoding Results .................................................... 20
   6.3 Visualizing Data with Wordle .................................................... 21

7. **Encoding Open Answers from Survey Projects** ........................... 23
   7.1 Planning Tips ............................................................................. 23
   7.2 Opening EFS Qualitative Analysis from a Survey Project ............ 24
   7.3 Creating Projects and Importing Data ........................................ 24
   7.4 Using Encoding Results in EFS Reporting + ............................... 27

Index .................................................................................................... 29
1 EFS Qualitative Analysis

EFS Qualitative Analysis is QuestBack’s new solution for analysing both community content and open answers from survey projects. The lightweight tool focuses on the needs of the analysts of customer insight communities. However, you can also use it for evaluating the data from open-ended questions in quantitative projects.

- Interesting quotes from forums, discussions, chats, blogs and news articles can be lifted off the panel website into EFS Qualitative Analysis with a simple click and tagged with user-defined codes.

- Answers to open-ended questions in conventional quantitative surveys can likewise be imported into EFS Qualitative Analysis for subsequent encoding. Answers to closed-ended questions can be included in the import as codes, i.e., the imported open answers can be tagged automatically with important demographic information, for example. An interface allows for the encoding results to be subsequently imported into EFS Reporting + and integrated into the result reports.

- You are absolutely free to choose your codes: from predefined quick labels for simple pro-contra judgments via “in vivo” encoding with phrases from the actual quotes up to complex code hierarchies - anything is possible.

- EFS Qualitative Analysis supports you in optimizing and further developing your encoding systems. Thus, codes may be re-ordered, merged, or organized in a hierarchical manner at a later date. Once you have developed an encoding system, it can be exported to be used in other EFS Qualitative Analysis projects.

- Powerful search functions allow you to locate subject-specific quotes for reports and presentations.

- The encoding results can be visualized in a code cloud. Furthermore, EFS Qualitative Analysis also features an interface to Wordle.

In this manual, all features of EFS Qualitative Analysis are introduced in detail. Additionally, you will find a video demonstrating the most important steps in the customer center at http://www.questback.com/customercenter.html.

If you are interested in using EFS Qualitative Analysis please get in touch with your QuestBack contact.
2 Virtual Tour

EFS Qualitative Analysis is not included in the standard version of EFS Survey or EFS Panel. It is optionally available to customers who own their own installation. To use the tool, it must be activated.

If your panel has been upgraded from 7.1 or an earlier version, a modification of the templates will be necessary, too. In particular, the CSS classes of the HTML tags which enclose the community posts must be modified. Otherwise, EFS Qualitative Analysis cannot detect the selected quotes. You will find instructions and sample files in the customer center.

EFS Qualitative Analysis enables you to compile and code quotes, while skipping through the community posts on your EFS Panel website.

In this first Chapter, you will be introduced to all important work steps and frequently-used features. In the following Chapters, specific topics as e.g. the management of evaluation projects and the creation of code structures will be explained in detail.

So, let’s start our virtual tour into EFS Qualitative Analysis:

1. First, specify which moderator or tester account you usually use. To do so, open the Staff -> Own account -> Preferences, then go to the Panel tab and select the appropriate moderator or tester account.

2. Open the Start page of the admin area (icon ) and log in to the desired website.
3. In the head section of the website, the EFS Qualitative Analysis toolbar is displayed.

![Figure 2.2 Toolbar on the panel website](image)

You can use the icon to diminish the toolbar.

4. The drop-down list contains all existing EFS Qualitative Analysis projects.
   - If a suitable project exists, you can start collecting quotes immediately.
   - If there is no suitable project yet or no project at all, simply click on Open the tool without selecting anything in the drop-down list. The project manager is opened in a new window. Click on the Create icon ( ). Enter the desired title. For now, you just want to code community data, therefore simply keep
“Do not import codes” activated. Confirm with **Create**. Then, go back to the browser window which contains the panel website.

![New Project dialog](image)

**Figure 2.3** Creating project

For detailed information on creating and managing projects, please see Chapter 3, p. 10.

5. Navigate to the community posts which you want to evaluate: in the example shown below, posts from a forum discussion are processed. Make sure the desired target project is selected in the toolbar.

![Forum discussion](image)

**Figure 2.4** Selecting a quote

EFS Qualitative Analysis supports the evaluation of quotes from forums, discussions, chats, blogs and news articles. Normal page content, as e.g. headers or texts, can not be imported for evaluation.

6. Mark the desired quote with the left mouse key.
7. In the layer which is opened, click on the option **Process quote**.
8. The quote is imported into EFS Qualitative Analysis and opened in the edit dialog.
9. Now you can assign codes to the quote and add comments in a memo:
   - Use quick codes (Thumbs up / down, Green / Red / Blue) for simple pro / contra assessments.
   - If you want to use a term from the quote as a code, mark it with the mouse pointer, then click on Assign as code. The new code is assigned to the quote and inserted into the list of existing codes.
   - Use the Add sibling and Add child icons to create additional codes and assign them per double-click or drag&drop.
   - Use drag&drop to arrange codes hierarchically.
   - Click on the Arrow icon to open the “Memos” field, enter a comment and click on + to store it.

For more information on code management, please go to Chapter 5, p. 15.

10. Select more quotes and assign codes to them.
11. Use the forward and backward icons to leaf through the collected quotes.

12. Open the Search tab. Use the search function to select quotes with specific content or specific codes (Chapter 4.2, p. 13).

13. Open the View tab (Chapter 6.2, p. 20). A data cloud is generated. It shows the frequency distribution of the codes which are assigned to the currently-selected quotes.
3 Creating and Managing Projects

3.1 Overview of Project Manager

EFS Qualitative Analysis projects are administrated in the project manager. The project manager is opened

- via the toolbar: just click on the Open the tool button without selecting any project.
- from the edit dialog via the Project manager icon (Figure 4.1).

The overview lists all projects on the current installation, including date and author. By clicking on the column headers, you can re-sort the list.

![Project Manager](image)

Figure 3.1 Project manager

To open a project, double-click on it. Alternatively, you can select the desired project and use the Open button.

Via the icons above the list, you can trigger the following actions:

- **Create**: The dialog for creating a new project is opened.
  - If you just want to tag your community data, simply enter a title and select “Do not import codes”.
  - If you want to adopt codes from an existing project or import external codes, please follow the detailed instructions in the following Chapter 3.2, p. 10.
- **Delete**: The selected project is deleted irrevocably.
- **Update**: The project list is updated. E.g. if another staff member has deleted or created a project in the meantime, the change will be visible after the update.

3.2 Creating Projects

To create a new project, please proceed as follows:
1. Open the project manager and click on the **Create** icon.

![Image of New Project dialog box](image)

**Figure 3.2 Creating project**

2. Enter the desired title.

3. If you simply want to code community data, all you need to do is activate “Do not import codes”.

4. If you want to use the code tree of an already-existing EFS Qualitative Analysis project, activate “Import codes from project” and select the desired project.

5. It is possible to import code trees from other EFS installations or externally-created encoding hierarchies, too. To do so, first, export the code tree from the source installation or format the externally-created code hierarchy according to the code sample in Chapter 5.3, p. 17. Then, select “Import codes from file” and select the XML file.

6. Confirm with **Create**.

For the evaluation of community content, you can create as many evaluation projects as you like.

If you want to evaluate open answers from a survey project, please note that you can create only one evaluation project. The creation process differs quite a bit from the process described above: for detailed instructions, please see Chapter 7.3, p. 24.
4 Processing Quotes

4.1 Overview of the Edit Dialog

The edit dialog of EFS Qualitative Analysis is already familiar from the previous Chapter. Before we proceed, let’s have a look at its most important features.

- In the head section on the left hand, you can access the project manager.
- On the left hand, you can find all existing codes.
  - the predefined quick codes.
  - a hierarchic display of your own codes, plus the number of their assignments, on the Tree view tab. The codes which have been assigned to the selected quote are colored in green.
  - on the Cloud view tab, the frequency distribution of your codes is visualized in a cloud.
- The workpad is placed on the right hand:
  - On the Edit tab, which you have already used in the previous chapter, you can leaf through the quotes, assign codes or write memos.
  - On the Search tab, you can search the quotes and/or memos for specific codes or texts.
On the View tab, you can create code clouds to visualize your results (Chapter 6.2, p. 20).

### 4.2 Searching Quotes

On the Search tab, you can search for quotes with specific content or with specific codes.

To get started, define the search criteria in the head section of the tab. Then, use the Search icon to launch the search process.

- You can select one or more codes (optionally including child codes), enter a search text or combine both. The selected criteria are connected with AND.
- Text search can cover quotes, memos or both.

In the lower section, the results list is displayed. Via the icons in the toolbar, you can edit the quotes:

- **Process quote**: The selected quote is opened on the Edit tab.
- **Go to the source of the quote**: The source text of the selected quote is opened, see Fig. 4.2. A breadcrumb allows to open the source text in the admin area.
- **Memos**: The memos which exist for the selected quote are opened.
- **Export**: The results are displayed in an attractively-formatted HTML list (Chapter 6.1, p. 19).
- **Generate Wordle from quotes**: The results are passed on to Wordle. Wordle analyses the frequency of the terms in the selected quotes and displays the result in a data cloud (Chapter 6.3, p. 21).

![Figure 4.2 Accessing the source text of a selected quote](image-url)
The restriction defined on the **Search** tab will be used on the **Edit** and **View** tabs as well.

- The **Search filter active** link shows that you are working with a restricted selection. Click on the link to display the search criteria.
- Via the icons, you can easily go back to the **Search** tab or simply reset the restriction.

![Figure 4.3 Display of the search filter](image)

![Diagram of search filter]
5 Managing Codes

5.1 Overview of Encoding Features

The following Figure shows all functions which are used to create and manage codes.

- The predefined quick codes can be used for simple pro / contra assessments (Thumbs up / down, Green / Red / Blue).
  - It is up to you to define the meaning of these quick codes in your project.
  - To assign a quick code, just click on it once.
  - Per quote, you can assign just one quick code of each group. I.e. a quote can be marked either with **Thumbs up** or with **Thumbs down**, but not both.
  - The quick codes are not included in the code tree export (Chapter 5.3, p. 17).
- On the **Tree view** tab, you can create and manage your own user-defined codes.
  - New codes are created using **Add sibling** / **Add child**. You can choose between simple creation (i.e. the code is only added to the tree) and assigning (i.e. the code will be assigned to the selected quote as well).
  - If you want to use a term from the quote as a code, mark it with the mouse pointer, then click on **Assign as code**. The new code is assigned to the quote and inserted into the list of existing codes.
– For subsequent editing, use the features **Rename, Merge, Delete** and **Actions ->Organize codes** (Chapter 5.2, p. 16).

– Use drag&drop to arrange codes hierarchically.

– The icons **Collapse all / Expand all** kann die Struktur geöffnet oder verkleinert werden.

- The **Cloud view** tab contains a cloud visualizing the user-defined codes. The font size shows how frequently a code has been assigned. This allows to identify codes which have been assigned multiple times on first gaze.

- Via **Actions->Download code tree as XML**, you can download your codes (Chapter 5.3, p. 17).

### 5.2 Organizing Codes

At the start of an evaluation project, you will usually leaf through the texts, selecting quotes for analysis and encoding them on the fly. This will result in a long list of spontaneously-assigned codes which needs to be grouped. EFS Qualitative Analysis provides a dialog created specifically for this purpose.

Please proceed as follows:

1. Open the organization dialog on root level. For this purpose, you will usually have to de-select the currently selected code. Keep the CTRL key pressed and click with your mouse pointer on the currently-selected code.

2. In the code toolbar, click on the **Actions** icon and select the option **Organize codes**.

3. The organization dialog is opened. The left column lists all codes which haven’t been assigned to any topics yet. If you have already sorted a few codes by topic, you will find these topics with their lists of codes on the right hand.

![Organize codes for: Root](image)

**Figure 5.2** Sorting codes by topic
4. If a code in the left list fits to an existing topic, just drag it into this topic’s code list.
5. Use the + entry field to create additional topics.

![Figure 5.3 Adding a topic](image)

6. To move a topic below another topic, click on the **Actions** icon and select the appropriate target topic.

![Figure 5.4 Moving a topic](image)

7. **Close** the dialog.
8. To create a more complex structure, select a topic in the **Tree view** and open the organization dialog again, but for the specified topic this time, not on root level! Then, proceed with creating subtopics and sorting codes into them.

### 5.3 Downloading the Code Tree

You can download your code tree in an XML file, e.g. to archive it or to use it in a new project on another EFS installation (Chapter 3.2, p. 10).

To do so, click on the Actions icon in the code toolbar and select the option **Download code tree as XML**. Then, store the XML file locally on your PC.

> If you format a code hierarchy which was created outside EFS Qualitative Analysis as shown below, you can import it, too!
Example

The figure below shows a sample code tree.

![Code Tree Diagram]

The following XML code corresponds to this code tree.

```xml
<?xml version="1.0" standalone="yes" ?>
<codes>
  - <code name="Code A">
    <code name="Subcode A1" />
    <code name="Subcode A2" />
  </code>
  - <code name="Code B">
    <code name="Subcode B1" />
    - <code name="Subcode B2">
      <code name="Subcode B2-1" />
      <code name="Subcode B2-2" />
      <code name="Subcode B2-3" />
    </code>
    <code name="Subcode B3" />
    - <code name="Subcode B4">
      <code name="Subcode B4-1" />
      <code name="Subcode B4-2" />
    </code>
  </code>
</codes>
```
6 Displaying and Visualizing Results

6.1 Exporting Coded Quotes

The coded quotes can be displayed in an attractively-formatted HTML list. You can save this list and add it as an attachment to your result report as an attachment. Or you can use Copy&Paste to transfer the contents into a text editor.

Please proceed as follows:

1. On the Search tab, select the quotes which you want to render in HTML.
2. Click on the icon.
3. Specify which additional information (search filter, codes, memos) you wish to includ in the list.
4. Confirm with Export.

5. Save the HTML page to your PC. Please mind: It depends of your browser and the plugins used how the page is stored, e.g. if background images are included.
6.2 Visualizing Encoding Results

The so-called “data clouds” are a popular means to visualize qualitative information, as e.g. encoding results. EFS Qualitative Analysis enables you to create clouds which show the frequency distribution of codes:

- The font size shows how frequently a code has been used in the selected batch of quotes. If necessary, you can also display the amount of assignments, or the amount of assignments of both the code itself and its subcodes.
- By double-clicking on a code, the associated quotes are opened on the Search tab.
- Various setting options and color schemes, which are explained in detail in Table 6.1, can be used to vary both the code selection and the design.
- Furthermore, you can drag additional codes into the cloud or delete codes.

To document the finished clouds, please use the screenshot functionality of your PC. It is possible to copy the codes into a text editor for further processing, too.

![Code cloud](image)

**Figure 6.2** Code cloud

To create a code cloud, please proceed as follows:

1. On the Search tab, select the quotes whose codes are to be visualized.
2. Go to the View tab.
3. Use the features in the head section to configure the cloud according to your requirements. Table 6.1 lists all options.
4. You can drag additional codes into the cloud.
5. If necessary, use the Delete icon below the cloud to delete superfluous codes.
6. By clicking on the icon, you can open the cloud in a new window and e.g. create a screenshot.
6 Displaying and Visualizing Results

6.3 Visualizing Data with Wordle

EFS Qualitative Analysis includes an interface to Wordle. Wordle allows to create and layout data clouds. In the EFS Qualitative Analysis context, there are two usage scenarios:

- You can import your finished code clouds into Wordle and profit from its advanced layout features of the tool.
- You can use Wordle to analyze the frequency of terms in selected quotes. At the start of the encoding process, for example, this allows to identify frequently-used terms which can be used as codes.

Please note: Wordle is a product of an external supplier, QuestBack is merely providing the interface.

- Java is needed for using Wordle.
- For detailed information on Wordle and examples, please check out http://www.wordle.net/.

### Processing code clouds with Wordle

Please proceed as follows:

1. Create a code cloud, following the instructions in Chapter 6.2, p. 20.
2. Click on the icon (Generate Wordle from codes) below the cloud.
3. The cloud is opened in the Wordle edit dialog and you can use Wordle to layout it.
4. Print the finished cloud or screenshot it.

<table>
<thead>
<tr>
<th>Option</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Results</td>
<td>It is possible to restrict the display to the most commonly used codes.</td>
</tr>
<tr>
<td>Color scheme</td>
<td>Various color schemes are available.</td>
</tr>
<tr>
<td>Show quantity</td>
<td>Optionally, you can display the number of assignments for each codes. Per default, this function is deactivated and the number of assignments is merely reflected by the font size.</td>
</tr>
<tr>
<td>Include child nodes</td>
<td>Per default, the number of assignments refers to only to the code itself. Optionally, the value can include the assignments of subordinated codes as well.</td>
</tr>
<tr>
<td>Reset cloud</td>
<td>The cloud is generated again from scratch. Manual modifications (e.g. manually added codes or deleted codes) are reset, i.e. they will be lost.</td>
</tr>
<tr>
<td>Regenerate cloud</td>
<td>All manual modifications are retained, merely color and position of the codes are assigned anew.</td>
</tr>
<tr>
<td>Clear cloud</td>
<td>The workpad is cleared.</td>
</tr>
<tr>
<td>Edit search filter</td>
<td>The Search tab is opened.</td>
</tr>
<tr>
<td>Reset search filter</td>
<td>The search criteria currently specified on the Search tab are reset.</td>
</tr>
</tbody>
</table>

Table 6.1 Setting options for the cloud display
Identifying frequently-used terms in a selection of quotes

Please proceed as follows:

1. On the **Search** tab, select the quotes which you wish to process in Wordle (Chapter 4.2, p. 13).
2. Click on the **Generate Wordle from quotes** icon.
3. Specify which texts should be used for generating the cloud: the quotes in EFS Qualitative Analysis or the original posts. If the original posts are chosen, Wordle will analyse the complete text of the original posts. (Please note: When handling open answers from qualitative projects, the complete answers are stored in EFS Qualitative Analysis, i.e. the choice of option does not matter.)
4. Optionally Wordle can format all texts in lower cases.
5. Confirm by clicking on **Generate wordle**.
6. The cloud is opened in the Wordle edit dialog and you can use Wordle to layout it.
7. Print the finished cloud or screenshot it.
Encoding Open Answers from Survey Projects

EFS Qualitative Analysis can be used to analyse open answers from survey projects, too. You use the edit dialog and the basic features familiar from community contents. Merely the login to the tool is designed differently, and some handy extra features allow to use the data richness of quantitative projects effectively.

- The evaluation projects for qualitative surveys are project-specific. You can access them comfortably via the new menu item EFS Qualitative Analysis (Chapter 7.2, p. 24).
- The projects are administrated via the project manager, as usual (see above, Chapter 3.1, p. 10).
- The open answers are not selected and transferred manually, but imported (Chapter 7.3, p. 24). During import process, you can semi-automatically encode the answers, using the results of closed answers, participant data or panel-specific data.
- The actual encoding of the open answers is completely analogous to the encoding of community contents (Chapter 4, p. 12).
- If you use EFS Reporting + to create the result report for your survey, you can export the results of your evaluation project and use them in EFS Reporting +.

7.1 Planning Tips

The first version of EFS Qualitative Analysis is optimized for usage in customer insight communities. Therefore, when using the tool for quantitative projects, you should be aware of a few peculiarities and restrictions. The following tips will help you with preparing and planning.

- You can create one EFS Qualitative Analysis project per EFS survey.
- You can evaluate answers to open questions and entries made in text fields.
- The open answers can be coded semi-automatically, using answers to closed questions, participant variables with characteristics (project type PE), master data and panelist data with characteristics and selected system master data (project type PA and MD).
- In quantitative surveys, you will usually not encode all open answers but just a sample. Otherwise, the time and effort would be too high.
  - For each selected open question, a sample of answers is drawn from the existing complete participant data records. The “consecutive number” will be transferred as well. When importing the encoding results into EFS Reporting +, this allows to re-allocate the codes to the appropriate data records.
  - The largest possible sample size per question depends of the number of open questions selected. The theoretical upper threshold is 1,000 answers in a project with only one question. To define the maximum size per question, this value is divided by the number of questions. Please note: EFS does not check how many participant records exist, i.e. the values displayed might be too high and it is possible to enter too high values.
• If you upload codes from other projects or from an XML file in the last step of the import process, please take care that these codes do not overlap with codes created in previous steps. Otherwise, it is not possible to create the project.

• If your EFS Qualitative Analysis project is correlated to an EFS survey, you can export the results after completion of the encoding process and use them in EFS Reporting+. Chapter 4.3 of the EFS Reporting+ manual provides detailed information on the import. Please note:
  – If you want to group encoding results into a multiple response list, it might be necessary to use recoding. For detailed information on multiple recodings, in particular, please see Chapter 8.3 of the EFS Reporting+ manual.
  – The number of variables which can be imported into EFS Reporting+ is limited: You can import up to 100 additional variables per report. Please check if this is sufficient for both the planned evaluation project and other required external data.

• For now, it is not possible to allocate the codes from EFS Qualitative Analysis directly to questions when importing them into EFS Reporting+. The codes are simply assigned to the participant data records. If the correlation between question and code is important for your result report, please label and use the codes in such a manner that the context of the assignment is unambiguous.
  – Example: If you use different quite specific codes “positive attitude to Open Source Material” / “positive attitude to Licensed Maps” depending on the context, you will still be able to understand in which context the codes were assigned, after importing the codes into EFS Reporting+. If you use a single code “positive” instead, doesn't matter if the texts are referring to Open Source Maps or Licensed Maps, the meaning will be unclear after import.

### 7.2 Opening EFS Qualitative Analysis from a Survey Project

In qualitative survey projects, you can open EFS Qualitative Analysis from the survey menu, via the new menu item EFS Qualitative Analysis.

• If an evaluation project exists already for your survey, the edit dialog will be opened (see above, Chapter 4.1, p. 12).

• If there is no evaluation project yet, the import wizard is triggered (Chapter 7.3, p. 24).

### 7.3 Creating Projects and Importing Data

To create a new evaluation project, please proceed as follows:

1. Click on the EFS Qualitative Analysis menu item in the survey menu to trigger the import wizard.

2. Move all open questions whose answers you wish to evaluate into the right select field. Then, confirm with Forward.
3. Specify how many answers you want to import per question.
   - For each selected question, a sample is drawn from the existing complete participant data records. The “consecutive number” will be transferred as well. When importing the encoding results into EFS Reporting +, this allows to assign the codes to the appropriate participants.
   - The largest possible sample size per question depends on the number of open questions selected. The theoretical upper threshold is 1,000 answers in a project with only one question. To define the maximum size per question, this value is divided by the number of questions. Please note: EFS does not check how many participant records exist, i.e. the values displayed might be too high and it is possible to enter too high values.

4. Confirm with **Forward**.

5. Optionally, you can use answers to closed questions and participant variables to encode the open answers semi-automatically. In step 3, move all closed questions which you wish to use into the right select field.
6. Confirm with **Forward**.

7. Specify how the answer options of the closed questions should be labelled when used as codes.
8. Next, repeat the selection process for participant variables (project type PE). In panel surveys (PA) and master data surveys (MD), you can use master data, panelist data with characteristics and selected system master data.

9. Enter the title of the project.

10. Usually, you will keep “Do not import codes” activated.

11. In analogy to the community projects described in Chapter 3.2, p. 10, you can use codes from other EFS Qualitative Analysis projects. If you want to use the code tree of an already-existing project, activate “Import codes from project” and select the desired project.

12. It is possible to import code trees from other EFS installations or externally-created code trees, too. To do so, first, export the code tree from the source installation or format the externally-created code tree according to the code sample in Chapter 5.3, p. 17. Then, select “Import codes from file” and select the XML file.

13. Confirm with Create.

### 7.4 Using Encoding Results in EFS Reporting +

If your open answers originate from an EFS survey, you can export your project after completion of the encoding process and import it into EFS Reporting +.

The CSV file used for data exchange is formatted as follows: The first column contains the consecutive number of the participants. The following columns contain all codes of the EFS Qualitative Analysis project. A 0/1 encoding (“0” = “not quoted”, “1” = “quoted”) shows if a code has been assigned to any of the analysed open answers of the respective participant.

**Exporting and importing projects**

Please proceed as follows:

1. Complete the encoding process.
2. Open the **Tree view**.
3. Click on the **Actions** icon in the toolbar and select the option **Export project**.
4. Save the CSV file.
5. Import the file into EFS Reporting +. For detailed instructions, please check Chapter 4.3 of the EFS Reporting + manual.
6. If you want to group encoding results into a multiple response list, it might be necessary to use recoding. For detailed information on multiple recodings, in particular, please see Chapter 8.3 of the EFS Reporting + manual.
Index

C
clouds
  codes 20
  continuing processing of clouds in Wordle 21
  frequently-used terms 22
  code clouds 20
codes
  downloading code tree 17
  identifying frequently-used terms with
    wordle 21
  importing 10
  importing into new projects 10
  organizing 16
   Customer Insight Community 5

E
exporting
  code tree 17

O
outputting in HTML 19

P
projects
  creating 10
  exporting 27
  managing 10
  project manager 10

Q
quotes
  exporting 19
  identifying frequently-used terms with
    wordle 21
  searching 13

S
searching 13

W
Wordle 5, 21

X
XML
  formatting code tree in XML 17